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Chapter 461

Conditional Power
and Sample Size
Reestimation of OneSample T-Tests for
Non-Inferiority
Introduction
In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the
experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to
evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional
power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to
the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power
over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment
techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow
and Chang (2007), Chang (2008), Proschan et.al (2006), and Dmitrienko et.al (2005).
This program module computes conditional and predicted power for the case when a one-sample t-test is used to test
whether the mean of a population is greater than or less than a specific non-inferiority bound. It also provides sample
size reestimation to achieve a specified conditional power value.

Technical Details
All details and assumptions usually made when using a one-sample non-inferiority t-test continue to be in force
here.

Conditional Power
The power of an experiment indicates whether a study is likely to result in useful results, given the sample size.
Low power means that the study is futile: little chance of statistical significance even though the alternative
hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the
study has started. When this happens, the study is curtailed.
461-1
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Conditional Power and Sample Size Reestimation of One-Sample T-Tests for Non-Inferiority

The futility of a study that is underway can be determined by calculating its conditional power: the probability of
statistical significance at the completion of the study given the data obtained so far.
It is important to note that conditional power at the beginning of the study before any data are collected is equal to
the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional
power will seldom result in study curtailment very early in the study.
From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage k for
rejecting a null hypothesis about a parameter θ at the end of the study, given the observed test statistic, Z k , is
computed as

 Z I − z1−α I K + θ (I K − I k ) 
,
Puk (θ ) = Φ  k k
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and the general lower one-sided conditional power at stage k is computed as

 − Z k I k − z1−α I K − θ (I K − I k ) 
,
Plk (θ ) = Φ 
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I
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where

θ = the parameter being tested by the hypothesis
k = an interim stage at which the conditional power is computed (k = 1, …, K – 1)
K = the stage at which the study is terminated and the final test computed

Z k = the test statistic calculated from the observed data that has been collected up to stage k
I k = the information level at stage k
I K = the information level at the end of the study

z1−α = the standard normal value for the test with a type I error rate of α.
If we define 𝜇𝜇𝑅𝑅 as the population reference, standard, or baseline mean, NIM as the non-inferiority margin, and 𝜇𝜇1
as the actual mean under the alternative hypothesis, then the parameter 𝜃𝜃 to test the one-sided non-inferiority
alternative hypotheses of 𝐻𝐻1 : 𝜇𝜇 > 𝜇𝜇0 (higher means better with 𝜇𝜇0 = 𝜇𝜇𝑅𝑅 − |𝑁𝑁𝑁𝑁𝑁𝑁|) or 𝐻𝐻1 : 𝜇𝜇 < 𝜇𝜇0 (higher means
worse with 𝜇𝜇0 = 𝜇𝜇𝑅𝑅 + |𝑁𝑁𝑁𝑁𝑁𝑁|) and other conditional power calculation components as outlined in Chang (2008)
page 69 are

θ = µ1 − µ0 (the expected difference under the alternative hypothesis)
Z k = ( x k − µ 0 ) Iˆk

Ik =
IK =

nk

σ2
N

σ2

(the t-statistic computed from the observed data)

(the interim information level)
(the final information level)

where

xk is the sample mean, estimating µ1 at stage k
Iˆk is the estimated information from the sample at stage k
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nk is the sample size at stage k

N is the total sample size

σ 2 is the variance of X (estimated by the sample variance).
Computing conditional power requires you to set σ 2 , µ 0 , and µ1 . Their values can come from the values used
during the planning of the study, from similar studies, or from estimates made from the data that has emerged.

Futility Index
The futility index is 1 − 𝑃𝑃𝑘𝑘 (𝜃𝜃)|𝐻𝐻1. The study may be stopped if this index is above 0.8 or 0.9 (that is, if
conditional power falls below 0.2 or 0.1).

Predictive Power
Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution
of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power
at stage k is given by

 Z I − z1−α I k 
,
Puk = Φ  k K


I
I
−
K
k


and the general lower one-sided predictive power at stage k is given by

 − Z k I K − z1−α I k 
,
Plk = Φ 


I
I
−
K
k


with all terms defined as in the equations for conditional power.

Sample Size Reestimation
As Chang (2014) points out, after an interim analysis, it is often desirable to recalculate the target sample size using
updated values for various nuisance parameters such as the variance. This process is known as sample size
reestimation.
One method of calculating an adjusted sample size estimate is to search for the sample size that results in a
predetermined value of conditional power. PASS conducts a binary search using the conditional power as the
criterion. The result is called the target sample size.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Conditional Power or Sample Size Reestimation.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate conditional power directly. To find appropriate values of sample size, a binary
search is made using an iterative procedure until an appropriate value is found.

Test
Higher Means Are
Use this option to specify the direction of the non-inferiority test.
If Higher Means are “Better”, the alternative hypothesis is H1: μ > μ0.
If Higher Means are “Worse”, the alternative hypothesis is H1: μ < μ0.

Conditional Power and Alpha
Conditional Power
Enter one or more values for the conditional power that is to be attained by the sample size search.
Conditional power is the probability of rejecting a false null hypothesis given the data that has been obtained so
far. It is a function of the effect size and the data that have been collected.
The valid range is between 0 to 1. Typically, values over 0.70 are considered high enough to continue a study,
while values below 0.10 considered grounds for curtailing the study.
You can enter a single value such as 0.80 or a series of values such as 0.80 0.85 0.90 0.95 or 0.7 to 0.97 by 0.05.
Alpha
This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error
occurs when a true null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025
for one-sided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
N (Target Sample Size)
This option specifies one or more values of the target sample size, the total number of subjects planned for the
study. This value must be an integer greater than one. Note that you may enter a list of values using the syntax
50,100,150,200,250 or 50 to 250 by 50.
nk (Sample Size to Look k)
Enter the sample size obtained through look k. If this value is greater than N, the value of N is increased to this
amount.

Effect Size – Means
μ0 (Non-Inferiority Mean)
This is the bound of the non-inferiority test hypothesis.
If NIM is the non-inferiority margin and μR is the reference, standard, or baseline mean, then when Higher Means
are “Better”, the alternative hypothesis is H1: μ > μ0, with μ0 = μR - |NIM| and μ0 < μ1. When Higher Means are
“Worse”, the alternative hypothesis is H1: μ < μ0, with μ0 = μR + |NIM| and μ0 > μ1.
μ1 (Actual Mean to Detect)
This is the actual mean at which conditional power is calculated. Care should be taken that this value is consistent
with the alternative hypothesis.
When Higher Means are “Better”, μ1 > μ0. When Higher Means are “Worse”, μ1 < μ0.

Effect Size – Standard Deviation
σ (Standard Deviation)
Enter a value for σ, the standard deviation. The source of the value you enter is controversial. Some think you
should enter the value used in planning the study. Others think you should use the value estimated from the data
obtained so far. Still others think you should use a confidence limit for σ created from the current sample.
You can enter a range of values such as 1 2 3 or 1 to 5 by 1.
Press the σ button to the right to load the Standard Deviation Estimator window.

Effect Size – Current Test Statistic
Zk (Current Test Statistic)
Enter the value of the t-statistic calculated from the data obtained through stage k. This value may be positive or
negative. Usually, the t-statistic ranges between -5 and 5.
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Example 1 – Computing Conditional Power
Suppose a study has been planned and is to be analyzed using a one-sided non-inferiority t-test at an alpha of
0.025. The reference mean is known to be 6 and the test will have a non-inferiority margin of 1. The test will have
a lower bound of μ0 = μR – NIM = 6 – 1 = 5. The sample size is 50. The standard deviation is expected to be
about 1.8. An interim analysis is run after half the data have been collected. This analysis yields a t-test value of
2.12. The data monitoring board would like to have the conditional power calculated for actual mean values of 5,
5.5, 6, and 6.5.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 1
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Conditional Power
Higher Means Are ................................... Better (H1: μ > μ0)
Alpha ....................................................... 0.025
N (Target Sample Size) .......................... 50
nk (Sample Size at Look k) ..................... 25
μ0 (Non-Inferiority Mean) ........................ 5
μ1 (Actual Mean to Detect) ..................... 5 5.5 6 6.5
σ (Standard Deviation) ........................... 1.8
Zk (Current Test Statistic) ....................... 2.12

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test ─────────────────────────────────────────────
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Cond.
Power
0.25726
0.76946
0.98325
0.99978

Pred.
Power
0.85040
0.85040
0.85040
0.85040

Target Current
Sample Sample Non-Inf Actual
Size
Size
Mean Mean
N
nk
μ0
μ1
50
25
5.00
5.00
50
25
5.00
5.50
50
25
5.00
6.00
50
25
5.00
6.50

Diff
δ1
0.00
0.50
1.00
1.50

Std
Dev
σ
1.80
1.80
1.80
1.80

Test
Statistic
Zk
2.120
2.120
2.120
2.120

Alpha
0.025
0.025
0.025
0.025

Futility
0.74274
0.23054
0.01675
0.00022

References
Jennison, C., and Turnbull, B.W. 2000. Group Sequential Methods with Applications to Clinical Trials. Chapman &
Hall/CRC. New York.
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Report Definitions
Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the data that
have emerged so far.
Predictive Power is the result of averaging the conditional power over the posterior distribution of the effect size.
N is the target sample size.
nk is the sample size obtained through stage k.
μ0 is the non-inferiority mean used to construct the hypotheses.
μ1 is the actual mean to detect under the alternative hypothesis at which conditional power is calculated.
δ1 = μ1 - μ0 is the mean difference that is to be detected by the completed study.
σ is the standard deviation of the response.
Zk is the value of the test statistic from the observed data at stage k.
Alpha is the probability of rejecting a true null hypothesis.
Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be stopped
because there is little chance of achieving statistical significance.
Summary Statements ─────────────────────────────────────────────────────────
The first 25 of the planned 50 subjects achieve 25.726% conditional power to detect a difference of δ1 = μ1 - μ0 =
0.00 using a non-inferiority t-test with a bound of μ0 = 5.00, an actual mean of μ1 = 5.00, a standard deviation of
1.80, and a significance level of 0.025. The t-value of the data that have emerged so far is 2.120. The futility index
is 0.74274.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are
given in the Report Definitions section.

Plots Section

This plot shows the relationship between conditional power and μ1.
461-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Conditional Power and Sample Size Reestimation of One-Sample T-Tests for Non-Inferiority

Example 2 – Validation
We could not find an example of a conditional power calculation for a one-sample non-inferiority t-test in the
literature. Since the calculations are relatively simple, we will validate the calculation of the third scenario of
Example 1 by hand.
In this case

I K = N /σ 2

I k = nk / σ 2
25
1 .8 2
= 7.7160494

=

𝑃𝑃𝑢𝑢𝑢𝑢 (𝜃𝜃) = Φ �
= Φ�
= Φ�

50
1.8 2
= 15.432099
=

𝑍𝑍𝑘𝑘 �𝐼𝐼𝑘𝑘 − 𝑍𝑍1−𝛼𝛼 �𝐼𝐼𝐾𝐾 + 𝜃𝜃(𝐼𝐼𝐾𝐾 − 𝐼𝐼𝑘𝑘 )
�
�𝐼𝐼𝐾𝐾 − 𝐼𝐼𝑘𝑘

2.12√7.7160494 − 1.959964√15.432099 + (6 − 5)(15.432099 − 7.7160494)
�
√15.432099 − 7.7160494

5.905473
�
2.777777

= Φ(2.125970)
= 0.983247

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 2
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Conditional Power
Higher Means Are ................................... Better (H1: μ > μ0)
Alpha ....................................................... 0.025
N (Target Sample Size) .......................... 50
nk (Sample Size at Look k) ..................... 25
μ0 (Non-Inferiority Mean) ........................ 5
μ1 (Actual Mean to Detect) ..................... 6
σ (Standard Deviation) ........................... 1.8
Zk (Current Test Statistic) ....................... 2.12
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test ─────────────────────────────────────────────
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Cond.
Power
0.98325

Target Current
Sample Sample Non-Inf Actual
Pred.
Size
Size
Mean Mean
Power
N
nk
μ0
μ1
0.85040
50
25
5.00
6.00

Diff
δ1
1.00

Std
Dev
σ
1.80

Test
Statistic
Zk
2.120

Alpha
0.025

Futility
0.01675

The conditional power of 0.98325 matches the value calculated by hand.
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Example 3 – Sample Size Reestimation
Suppose a study has started. It is being conducted to detect a difference of 0.6 using a one-sided non-inferiority ttest at an alpha of 0.025. The reference mean is thought to be 6 and the test will have a non-inferiority margin of
1. The test will have a lower bound of μ0 = μR – NIM = 6 – 1 = 5. The target sample size is 50. The standard
deviation is expected to be about 1.8.
An interim analysis was run after half the data were collected. This analysis yields a z-test value of 2.12. This test
value was the result of transforming the p-value of the t-test with the inverse, standard normal distribution. The
sample standard deviation was 3.27.
The data monitoring board would like to have the sample size reestimated to obtain a conditional power of 0.8.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may make the appropriate entries as listed below or open Example 3
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size Reestimation
Higher Means Are ................................... Better (H1: μ > μ0)
Conditional Power................................... 0.8
Alpha ....................................................... 0.025
nk (Sample Size at Look k) ..................... 25
μ0 (Non-Inferiority Mean) ........................ 5
μ1 (Actual Mean to Detect) ..................... 5.6
σ (Standard Deviation) ........................... 3.27
Zk (Current Test Statistic) ....................... 2.12

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for One-Sample T-Test ─────────────────────────────────────────────
Hypotheses: H0: μ ≤ μ0 vs. H1: μ > μ0

Cond.
Power
0.80140

Target Current
Sample Sample Non-Inf Actual
Pred.
Size
Size
Mean Mean
Power
N
nk
μ0
μ1
0.92561
149
25
5.00
5.60

Diff
δ1
0.60

Std
Dev
σ
3.27

Test
Statistic
Zk
2.120

Alpha
0.025

Futility
0.19860

Notice that the target sample size has increased from 50 to 149.
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